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Chapter 1
Activating and Configuring the

RightFax Microsoft Exchange Module

The RightFax Microsoft Exchange Module acts as a communication
link between the RightFax server and your Exchange server,
allowing your users to use Microsoft Outlook to send, receive, and
organize fax documents. Outbound e-mail messages addressed to
the RightFax Microsoft Exchange Module are picked up by the
RightFax server, which converts them into faxes and transmits
them. Incoming faxes can be routed to an e-mail mailbox by
specifying each RightFax user's mailbox information in Enterprise
Fax Manager. The module can also provide notification of fax events
via e-mail.

With the RightFax Microsoft Exchange Module, you can also
synchronize your RightFax and Exchange user databases. This lets
you administer both systems directly from your Exchange
administration program and ensure that both Exchange and
RightFax client information is consistently and correctly updated.

The RightFax Microsoft Exchange Module is comprised of several
components that allow two-way communication between the
Exchange and RightFax servers:

¢ One or more RightFax modules are enabled on the RightFax
server and can be configured from Enterprise Fax Manager (see
“Adding and Configuring the RightFax Microsoft Exchange
Module Service” on page 6).

¢ The RightFax Connector is an Exchange service that handles all
communication between the Exchange and RightFax servers as
well as user database synchronization. The RightFax Connector
consists of connector objects and the RightFax connector
service and is configurable from the Exchange Admin program
(see “Configuring the RightFax Connector for Microsoft
Exchange 5.5" on page 15).

¢ Outlook forms allow Microsoft Outlook clients to create and send
faxes from a RightFax form built into and launched directly from
Outlook. Outlook forms also let clients receive new faxes into a
form that includes a built in fax viewer. Advanced forms can be
installed on each client workstation separately or a simplified
form can be made available to all Outlook clients without a
separate installation on each workstation. When you install the
advanced Outlook form, a custom fax button is also added to the
Outlook toolbar that lets users easily create and address new
faxes.

o Active Directory support for Exchange 2000 and 2003, allow for
unified administration of both the Exchange and RightFax servers.
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Adding and Configuring the RightFax Microsoft
Exchange Module Service

Before You Activate the RightFax
Microsoft Exchange Module

The RightFax Microsoft Exchange Module supports the following
versions of Microsoft Exchange only:

¢ Microsoft Exchange 2000 SP3
¢ Microsoft Exchange 2003
One of these versions (upgraded to the appropriate service pack if

necessary) must be installed on a network server that meets or
exceeds Microsoft's minimum hardware requirements.

Before activating the RightFax Microsoft Exchange Module on the
RightFax server, log on to the RightFax server using an ID with local
administrative rights. If you do not, the installation and configuration
will fail.

Installing the RightFax Microsoft
Exchange Module

The files required by the RightFax Microsoft Exchange Module are
installed on all RightFax servers during the server installation.
However, the RightFax Microsoft Exchange Module must be
licensed and activated before its functionality will be enabled.

To activate the RightFax Microsoft Exchange Module, you must
have licensed a RightFax server type that includes this module, or
purchased and licensed this module separately. For information on
activating new components on the RightFax server, refer to the
RightFax Installation Guide.

After the RightFax Microsoft Exchange Module has been activated
on the RightFax server, you must add and configure the RightFax
Gateway for Microsoft Exchange service (described in the next
section).

After your RightFax server has had the RightFax Microsoft
Exchange Module functionality enabled, open Windows Control
Panel and run the E-mail Gateway configuration program. (If you
already have one or more e-mail gateways configured, you can
open the E-mail Gateway configuration program by double-clicking
the RightFax E-mail Gateway service in Enterprise Fax Manager.)

To add a new gateway, click Add Gateway. Select Microsoft
Exchange from the list of gateways and then click Select.
Because RightFax allows you to install multiple e-mail gateways,
each installed gateway is listed in the tree in the left pane. Click
each gateway in the list to view its configuration options. Each
e-mail gateway you add must be separately configured to work with
your Exchange server and your network environment.

Configuring the options on the General tab

Figure 1.1 The General Tab on the E-mail Configuration Dialog Box

B Gateway 1 - MSEXCH General | Custom messages |

Location of mail files: IC.\PHDGHAM FILESARIGHTFA=MGATE

FROM message: |thhtFak E-mail Gateway

Drefault farm: IStandardform 'I Event Loglevel ITerse ‘I
™ Remote E-mail gateway service R IE

™ Use PCL convertor for text files

] (s Bl Top margin of meszage header: |3

¥ Send through DEFALLT user when e-mail sender is unknown

Add Gateway...| Delete Gateway Select Service Account.. | Cancel |




Because RightFax allows you to install multiple e-mail gateways,
each installed gateway is listed in the left pane. Click MSEXCH to
view the Gateway for Microsoft Exchange configuration options.

Location of mail files The Gateway for Microsoft Exchange
creates In and Out subfolders under the folder you specify here.
The In folder is where the gateway will place incoming mail-bound
faxes for delivery to the Exchange server. The Out folder is where
the gateway will look for outgoing fax-bound mail messages for
delivery to the RightFax server.

You must specify a folder on the Exchange server. You can specify
any folder on the Exchange server; however, by default, the
gateway connector service account (described on page 9) looks
for the In and Out folders in the connector install folder,

Program Files\RightFax\RFaxGate.

FROM message Enter a descriptive name that will appear in the
From field of all inbound documents sent to Exchange from the
RightFax server.

Default form If you have installed Outlook fax forms for your
Outlook clients (see “Installing the RightFax Forms for Outlook” on
page 23), select the form you want Outlook users to see when
opening received fax messages.

Remote E-mail gateway service Allows the e-mail gateway
processes to execute on a remote computer rather than on the
local computer. (It also prevents the e-mail gateway service from
being started by the RightFax server, so do not select this check
box if you don't intend to run the gateway remotely.) For more
information on running the gateway remotely see “Running the
RightFax Microsoft Exchange Module Remotely” on page 9.

Use PCL convertor for text files Uses the RightFax PCL
conversion engine when converting e-mail messages to fax format.
This conversion method usually produces more accurate fax
images of ASCI| text than RightFax's native document conversion
engine. If you notice that e-mail messages are not converting to fax
format as accurately as you expect, clear this check box to return to
using the native document conversion engine.

Disable outbound faxing Prevents Outlook clients from
sending mail messages to fax addresses. When you select this
option, the Gateway for Microsoft Exchange will only serve to route
received faxes and notifications to Outlook clients.

Send through DEFAULT user when e-mail sender is
unknown Assigns fax ownership to the RightFax “Default” user
ID when a fax is sent from an Outlook client who does not have a
RightFax user ID. If this option is not selected, faxes sent from
Outlook clients that have no matching RightFax user ID will not be
sent.

Event Loglevel Select the level of information logged in the
Application Event Log under the service name “RightFax E-mail
Gateway Module! The Terse setting records critical errors only.
Verbose records all significant events and is most useful for
tracking and resolving problems. Note that if you leave this value
set to Verbose for long periods of time, the Event Log can become
full which may prevent new events from being logged.

Note Information written to the Application Event Log is valuable in
tracking down problems. If you have a problem that can be duplicated,
set the LogLevel for all RightFax server applications to Verbose, then go
through the steps to duplicate the problem. The data stored in the
Application Event Log may help you resolve the problem.

Frequency Sets the interval, in seconds, between checks to the
mail system and the RightFax system for work to do (such as
received faxes to route or e-mail to convert to faxes). Decreasing
this value is not recommended as it may unnecessarily increase the
load on the fax server.

Top margin of message header Enter the number of lines to
add to the top margin of mail messages when converting to fax
format. Adding a few lines to the top margin may prevent come
plain paper fax machines from cutting off the top of the message
headers.
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Configuring the options on the Custom Messages tab

When a fax is received as an e-mail attachment and when an e-mail
notification about the status of a fax is received, the received mail
message includes one or more customizable messages providing
information about the status of the fax. To customize the text of
these messages, click the Custom Messages tab.

Figure 1.2 The Custom Messages Tab

Bs Gateway 1 - MSEXCH General  Custom messages |

Sent/Received time: |Time: 1

Received remate 1D: |F\eceived fram remate (D: ~1

Sent remate | ISent ta ™1 with remote [D "2

Inbound user: |Inb0und uzer [0 1, routing code ~2

Result: |Hesult: ~1

Page record: IF’age record: ™1

Nane sent: Ino pages sent

Elapsed time: IEIapsed time: ~1 on channel ~2

Add Galeway...l Delete Galewayl

Select Service Account.. | Cancel |

Each message lets you combine text with one or more variables.
Each message has its own available variables, described in the

following table.

Table 1a E-mail Gateway Custom Message Settings

Notification
message

Variables

Sent/Received time

~1 = Date (in Windows locale format) and
time (HH:MM)

Received remote |ID

~1 = Remote ID

Sent remote ID

~1 = The destination fax number
~2 = The destination remote |ID

RightFax 9.0 Microsoft Exchange Module Guide

Table 1a E-mail Gateway Custom Message Settings (Continued)

Notification

message Variables
Inbound user ~1 =The RightFax user ID of the fax
recipient

~2 = The fax recipient's routing code

Result

~1 =The result code and any
accompanying text as reported by the fax
board (These codes and messages may
differ depending on your fax board type)

Page record

~1 =The range of page numbers
successfully sent or received

None sent

None.

Elapsed time

~1 = The total time that the fax spent being
processed by the fax board displayed
(MM:SS)

~2 = The fax channel used to send or
receive the fax.




Selecting a service account automatically started and stopped by the RightFax Server service
and you should not stop the RightFax E-mail Gateway Module
service manually. If the gateway is running on a remote machine
(see “Running the RightFax Microsoft Exchange Module Remotely”
on page 9) you must start and stop the RightFax E-mail Gateway
Module service manually.

The RightFax Gateway for Microsoft Exchange logs on to the
network as a service using a Windows user account that you
specify. To change the gateway service account, click Select
Service Account. This opens the Select Service Account dialog
box.

Figure 1.3 The Select Service Account Dialog Box

Running the RightFax Microsoft Exchange
Select the account the Services will use to startup.
NDTE.b”quu will be slUéing or accessing fies on : Metware volume, make sure the Service account exists as an account within Movell. Also M Od u Ie Rem Otely
remember that passwards are case sensitive.
By default, the RightFax Microsoft Exchange Module service runs
on the RightFax server. You may choose to run the E-mail Gateway
Dromain or W orkgroup: . . . e
[T Module service on a different machine if:
User Ancount: ¢ You want to decrease the workload on the RightFax server.
° ¢ You anticipate a high volume of gateway traffic and don't want
the added workload to interfere with the routine operation of the
_— RightFax server.
——
Corfiim Password: To run the RightFax E-mail Gateway Module service
remotely
o | cencel | LosdUsers | 1. On the RightFax server, run the E-mail Gateway module
configuration program from Windows Control Panel.
Enter the new service account in the Domain or Workgroup and 2. Click Add Gateway. Select Microsoft Exchange and click
User Account boxes. You can also click Load Users to scan for Select.

and list all user accounts on the network, and then click a user
account in the list to fill in the Domain or Workgroup and User
Account boxes. Enter the case-sensitive password for the selected
user account in both the Password and Confirm Password boxes. 4. Set the Location of mail files option to the UNC path of the
Click OK to apply the new service account. RightFax\Gateway folder (for example
\\RFSERVER\C$\Program Files\RightFax\Gateway).

3. Highlight the new gateway in the pane on the left and select the
Remote E-mail gateway service option.

Starting and stopping the gateway service

After installing the Gateway for Microsoft Exchange, a new service
called “RightFax E-mail Gateway Module” is created. If the gateway
is running on the fax server, the service is set to “Manual” and is

Chapter 1 Activating and Configuring the RightFax Microsoft Exchange Module



5. Click Select Service Account and make a note of the domain
and user account used by your gateways. For security
purposes, the password for the user account will not be
displayed, but you must have this information as well as the
password for use later in these steps.

6. Click Cancel to close the Service Account dialog box, and then
click OK to save and close the E-mail Configuration dialog
box.

7. Add the gateway user account you noted above to the
Administrators group on both the RightFax server and the
remote E-mail Gateway computer.

8. Log on to the remote E-mail Gateway computer using the E-mail
Gateway service account user name and password.

9. Map a drive to the administrative share for the drive on which

the RightFax server is installed (for example, \RFSERVER\C$).

10.0Open a command prompt and change to the RightFax\Bin
folder on the drive you mapped and enter the following
command:

addsrv gateway# “RightFax Remote Gateway# Module”
“\\RFSERVER\C$\Program Files\RightFax\Gateway
\EXCHGateway.exe”

Where # is the number of the E-mail Gateway you added on the
RightFax server, and RFSERVER\C#$ is the name of the
administrative share on the RightFax server. When complete,
the message “Create Service Success” appears. Close the
command prompt window.

11.0pen Windows Control Panel, select Administrative Tools,
and start the Services program.

12.In the list of services, double-click “RightFax Remote Gateway#
Module” (Where # is the E-mail Gateway number). This opens
the Properties dialog box.

13.Under Startup Type, select Automatic.
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14.Under Log on as, select This account and then click the
browse button to open a dialog box listing available user
accounts.

15.0pen a list of user IDs on the E-mail Gateway service account
domain, and then double-click the E-mail Gateway service
account user ID you noted earlier. Click OK to return to the
Services dialog box.

16.In the Password and Confirm Password boxes, type the
password for the selected service account. Click OK, and then
click Close.

17. Close Windows Control Panel.

18.0pen the registry editor and navigate to
HKEY_LOCAL_MACHINE\System\CurrentControlSet
\Services\GATEWAY #

Where # is the number of the E-mail Gateway.

19.From the Edit menu, select New, and then select String Value.
Type AppParameters and press ENTER to name the new
registry key.

20.Double-click the new AppParameters key to open the Edit
String dialog box. In the String box, enter:

-fRFSERVER -sgateway# -L\RFSERVER\C$\
Progra~1\RightFax

where RFSERVER is the name of the RightFax server, # is the
E-mail Gateway number, and \RFSERVER\C$\Progra~1\
RightFax is the UNC path to the RightFax folder on the RightFax
server. (The short name format is required.)

21.In the registry editor, navigate to HKEY_CLASSES_ROOT and
add a new key called RightFax.

22.Under the RightFax key, add a new key called Server.
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23.Add a new string value to the Server key called Path. In the
Data value box enter the UNC path to the RightFax\Shared files
folder on the RightFax server (for example,
\RFSERVER\C$\Program Files\RightFax\Shared files).

24.Close the registry editor.
25.Run the Services program from Windows Control Panel

26.Select the “RightFax Remote Gateway# Module” service. If the
service is running, click Stop. When the service is stopped,
click Start. RightFax will now begin using the remote E-mail
Gateway service.

Troubleshooting the RightFax
Microsoft Exchange Module

If you experience problems with your RightFax Microsoft Exchange
Module service, you should first check for errors in the Application
log of the Windows Event Viewer. To open the Event Viewer, select
Start > Programs > Administrative Tools > Event Viewer. In the
Event Viewer, select Application from the Log menu to open the
Application log. E-mail gateway-related problems will appear on the
log in the Source column as “RightFax E-mail Gateway Module.
Double-click the entry for a description of the error.

The information saved to the Event log is determined by the
LogLevel setting in the RightFax E-mail Gateway configuration
program (described on page 7). With the log level set to Terse,
only critical errors will be recorded. Log levels Normal and
Verbose record more information that may help track down
problems.

Running the RightFax Microsoft Exchange Module service in a
command prompt window will also give a very detailed account of
what is happening with the gateway.

To run the gateway in a command window

1. Stop the RightFax E-mail Gateway Module service.
2. Open a command prompt window.

3. Change to the RightFax\Gateway folder on the RightFax server
and enter this command:

exchgateway -d -1 -sgateway#

Where # is the number of the e-mail gateway. This number is
zero-based, so your first e-mail gateway is referred to as
“gateway,’ your second e-mail gateway is referred to as
“gateway1,” and so on. To confirm the gateway number, open
the Windows registry and check the Gateway keys under
HKEY_LOCAL_MACHINE\SOFTWARE\RightFax\Gateways.

Example exchgateway -d -1 -sgateway

When running the e-mail gateway in a command window, you must
set the window properties to allow you to scroll backwards some
distance. To set the command window to sufficient size, click the
MS-DOS icon in the top left of the command window. Click
Properties to open the Command Prompt Properties dialog box.
Click the Layout tab, and then set Screen Buffer Size height to
2000.

Resolving error messages

Error 2140 starting service or logging into Exchange

Ensure that the appropriate Windows NT account is being used.
Open the Services program in Control Panel. Highlight RightFax
E-mail Gateway and click Startup. The Account box should
display an account name. If not, start the gateway with an account
that has administrative access. The default is RIGHTFAXUSER.
Log off and back on using this account.

Chapter 1 Activating and Configuring the RightFax Microsoft Exchange Module
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Error 53

This is a Windows NT networking error which indicates that the
UNC name which was specified for the Location of Mail Files in
the gateway configuration is an invalid network path. If the
specified path is correct and valid, it may be that the account being
used to start the E-mail Gateway Module service does not have
access rights to that folder.

Error 85 The local device is already in use

This is a Windows NT networking error stating that the drive to
which RightFax is trying to connect the UNC name that was
specified for the Location of Mail Files, or API Files is already
assigned.

Faxes are going out, but no e-mail notifications are being
sent

Normally, users who send faxes via mail do not have a RightFax
account and the faxes will be routed through the RightFax Default
fax mailbox. When a fax goes out, RightFax tries to notify the user of
the fax status. Since the fax went through the Default fax mailbox,
RightFax will try to notify the network user Default, thus the
notification never reaches the sender.

Cannot access inbound/outbound folder

The folder entered as the Location of In/Out Directories box on
the RightFax Connector dialog box is invalid (see “In/Out
Directories” on page 17). The path specified may not exist, may be
misspelled, may not use proper UNC naming conventions, or the
user account specified for the RightFax Connector Service may not
have administrative access to the specified folder.

RightFax 9.0 Microsoft Exchange Module Guide

Error resolving destination mailbox: MailBoxName

An incoming fax from the RightFax server could not be converted
correctly. This is usually due to the user's Routing Info box in
Enterprise Fax Manager not matching a display name of an
Exchange mailbox. Make sure the user's RightFax user ID matches
an Exchange user’s Display Name.
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Chapter 2
Installing the RightFax Connector

Note These instructions apply to both versions 2000 and 2003 of the |nsta||ing the R|g htFax Connector
Microsoft Exchange server. Throughout this chapter, instructions that Mi ft Exch 200x S
pertain to either version of Exchange will refer to Exchange 200x. on Icroso Xchange X Servers

To install the RightFax Connector for Microsoft Exchange, you must
be logged on to the Exchange server with an account that is a
member of all of the following Exchange groups:

After you have installed and configured the RightFax Microsoft
Exchange Module, you must install and configure the RightFax
Connector. This is the Exchange service that handles all

communication between the Exchange and one or more RightFax o Enterprise Admins
servers. The connector object is indicated in bold in the following o Schema Admins
description: e Domain Admins
Organization
Routing Groups To install the RightFax Connector for Microsoft Exchange
Routing Group 200x
Connectors
Connector for Captaris RightFax 1. Log on to the Exchange server.

The RightFax Connector for Microsoft Exchange is made up of 2. Insert the RightFax server CD. If AutoRun is enabled, a menu of
several files that direct the fax process through Exchange 200x: install options appears. If AutoRun is not enabled, browse the

. . . CD and run AutoRun.exe.
o RFaxgate.exe is the main connector service.

3. In the menu of install options, select the option to install the

o RFax_in.dll performs inbound fax information processing.
! pertorms inbot X imormation pr "o RightFax product suite. The RightFax install wizard opens.

o RFax_out.dll performs outbound fax information processing.

4. Click Next at the opening screen to view the RightFax license
agreement. You must accept the license agreement in order to
continue the installation. Click Next.

¢ ExchSnap.dll handles fax configuration in Exchange System
Manager.

5. Enter your name, organization name, and your product serial
number when prompted. Click Next.
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6. On the Setup Type screen, select Custom and then click Next.

7. On the Setup Features screen, remove all install options
except the option Exchange 2000/2003 Connector under the
Connectors group. Click Next. This will start the RightFax
Connector setup wizard.

8. Click Next after reading the initial Information screen to open
the Installation Options screen.

9. Select Complete or Custom, and then click Next.

Note If you want to install the connector to a folder other than the
default folder Program Files\RightFax\RFaxGate, or if you want to
install the MMC Administrative Tool (described on page 14) only, you
must select the Custom option.

10.Click Next on each of the Install Options screens. In most
cases, accepting the default settings on these screens is
recommended. When prompted, click Install.

11.The Exchange 200x schema must be updated in order to
proceed with the install. If this is necessary, you will be
prompted to begin updating the schema. This process may take
a few minutes or as long as several hours, depending on the
size of your Active Directory domain.

A message may appear indicating that the install is unable to
add the connector object. Click Retry to check the progress of
the update. If the update is still in progress, the message will
reappear. If the update is complete, the message will close and
the install will continue.

12.1f the setup program detects multiple Exchange 200x servers on
your network, you will be prompted to select the server to install
the connector on. Select the server you want, and then click
Next.

13.Click Finish to complete the install.

14.When the install is complete, run the Services application in
Windows Control Panel and start the RightFax Connector
service.

RightFax 9.0 Microsoft Exchange Module Guide

To Configure the RightFax server to work with the
connector

After the connector software has been installed, follow these steps
to configure the RightFax server:

1. On the RightFax server, run Enterprise Fax Manager.

2. Open the RightFax server that has the RightFax Microsoft
Exchange Module installed and double-click RightFax E-mail
Gateway Module in the list of services. This opens the E-mail
Configuration dialog box. Click the General tab.

3. In the Location of mail files box, enter the location of the
message transfer directory you specified during the connector
installation. If you accepted the default folder location during the
connector installation on the Exchange server, this is the
ExchServer\Program Files\RightFax\RFaxGate folder.

Configuring the RightFax Connector
for Microsoft Exchange 200x

A

After the connector is installed, you can customize the connector
configuration settings in the Exchange System Manager using the
MMC Administrative Tool.

Note You can install the MMC Administrative Tool for the RightFax
Connector on any computer that has Exchange System Manager
installed. To install the MMC Administrative Tool only, run the installation
program for the RightFax Connector for Exchange 200x (described on
page 13), select the Custom option, and then select only the MMC
Administrative Tool option from the list of components.

14



To configure the RightFax Connector for Microsoft
Exchange 200x
1. Run the Exchange System Manager program.

2. Navigate to Connectors, right-click Connector for Captaris
RightFax, and then select Properties in the shortcut menu.

The rest of this section describes each of the options in this dialog
box.

The General tab

Figure 2.1 The Connector for Captaris RightFax Properties General Tab
Connector for Captaris RightFax [Sel\lr _"Iﬁl

Gengral | Fax Sarverl Address Space I Delivery Flastrictionsl Details I

% Connector for Captaris RightFax [Server]

Message size:
& No limit

" Maimum [KB]: I

Delivery order:

|FIFo =
Lagaing level: IDebug b

I Enable message tracking

Ok I Cancel | Lipply |

Message size Select No limit to accept all messages from the
fax server regardless of the file size of the message. Select
Maximum (KB) to specify the maximum file size of messages that
the Exchange server will pass to the fax server. Enter the maximum
file size in kilobytes. Messages that exceed this file size will not be
forwarded to the fax server.

Delivery order Select the sequence that the Exchange
Message Transfer Agent (MTA) will use when delivering mail to the
connector:

e FIFO. The MTA delivers messages to the connector on a first-in
first-out (FIFO) basis.

o Priority. The MTA delivers messages marked with a high priority
first.

¢ Size. The MTA delivers messages that are smallest first.

Logging level Select the level of information that will be logged

in the Application Event Log under the service name “RightFax

E-mail Gateway Module!” Normal records critical errors only.

Debug records all significant events and is most useful for tracking
and resolving problems.

If you leave this option set to Debug for long periods of time, the
Event Log can become full very quickly, which will prevent new
events from being logged.

Enable message tracking Select this option to write a
tracking event in the Exchange Message Tracking Log for each fax
message successfully sent to or received from the fax server.

For received faxes, the Message Tracking Log records:

o The unique ID of the fax, assigned by the fax server.

« The caller service identification (CSID) of the sending fax
machine.

¢ The object distinguished name of the fax recipient.
For sent faxes, the Message Tracking Log records:
¢ The Exchange ID of the sender.

¢ The destination address for the fax.

o The message transfer system identification (MTS-ID) assigned by
the connector.

When message tracking is enabled, you can force all faxes sent via
the connector to use the last 15 digits of the MTS-ID as the unique
ID of the fax. This will help you locate faxes on the fax server that

Chapter 2 Installing the RightFax Connector
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have been identified in the Exchange Message Tracking Log. To
enable this feature, edit the Windows registry. Navigate to
HKEY_LOCAL_MACHINE\Software\RightFax\Gateway
\Gateway#. Next, add the registry value class DWORD and the
value “UseMTSID! Set its value to hexadecimal “Ox1" by entering 1
in the DWORD editor.

The Fax Server tab

Figure 2.2 The Connector for Captaris RightFax Properties Fax Server
Tab

Connector for Captaris RightFazx [Server] _"Iﬁl

General  Fax Server | Address Space I Delivery Flastnchnnsl Detailz I

Message transfer directories:

Directory | Priority |
C:\Program Filez\RightFAs\RF&=Gatel, 1

Add.. Modify... Remove

Administrator:

0k, I Cancel | Aipply |

Message transfer directories Message transfer directories
store the mail messages that are being routed to the fax server and
the fax images that are being routed to the Exchange server. You
must specify one message transfer directory for each fax server
that the Exchange 200x connector will communicate with. The
message transfer directory must be a local folder on the Exchange
server, and it must be specified as a standard path (for example,
C:\Program Files\RightFax\RFaxGate). Each RightFax server with
the RightFax Microsoft Exchange Module installed is configured to
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communicate with one message transfer directory (see “To
Configure the RightFax server to work with the connector” on
page 14).

Each message transfer directory is assigned a priority. The
RightFax connector will always use the message transfer directory
with the lowest priority setting. If a directory can't be found, it will
use the next lowest. If two directories have the same priority, the
connector will alternate directories.

Administrator Select an Exchange Admin account that will
receive undeliverable inbound fax messages and notification of
synchronization events.

The Address Space tab

Figure 2.3 The Connector for Captaris RightFax Properties Address
Space Tab

Connector for Captaris RightFaz [Server] _‘7|5|
Eenarall Fax Server Address Space | Delivery Flastnchnnsl Detallsl

Create, modify, or remove an address space:

Type ‘ Address | Cost ‘
Fa * 1

RF&x * 1

Add [ mclifiy Femove

— Connectar scops
% Enlire organization
' Routing group

0k, I Cancel | Aipply |

Create, modify, or remove an address space Thisis a list
of the Exchange address spaces that will be routed to the fax
server. All messages within the address spaces specified here will
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be routed to the fax server. By default, messages with the FAX and
RFAX address types (described on page 29) will be routed to the
fax server by the connector.

Connector scope Select Entire organization to enable the
connector for all servers on your network. Select Routing group to
enable the connector only for servers in the local routing group.

The Delivery Restrictions tab

Figure 2.4 The Connector for Captaris RightFax Properties Delivery
Restrictions Tab

Connector for Captaris RightFax [Selve!;' 2=l
Eenarall Fax Sarverl Address Space  Delivery Restrictions | Details I
By default, messages from everyone are:

& Accepled " Rejected

Aecept messages from:

Femove,..

Reject messages from:

Add... Femove,.. |

0k, | Cancel | Aipply |

By default, messages from everyone are Click Accepted
to accept fax-bound messages from all sources. If you select this
option, you will still be able to reject messages from specified
sources. You should select this option if you intend to accept
messages from all but a few sources. Specify the exceptions in the
Reject messages from box.

Click Rejected to reject fax-bound messages from all sources. If
you select this option, you can still accept messages from specified
sources. You should select this option if you intend to accept
messages from only a few sources. Specify the exceptions in the
Accept messages from box.

Accept messages from This is a list of senders from whom
messages will be accepted. You may want to add Exchange users
to this list if you select Rejected as the default for all users. If so,
the connector will only accept messages from users listed here.

Reject messages from This is a list of senders from whom
messages will be rejected. You may want to add Exchange users to
this list if you select Accepted as the default for all users. If so, the
connector will accept messages from all users except those listed
here.

The Details tab

Figure 2.5 The Connector for Captaris RightFax Properties Details Tab

General I Fax Server I Address Spacel Delivery Restrictions  Details |

Creation date: E/26/2001 11:47:43 PM
Last modification: B/27/2001 2:08:05 AM

Administrative note:

[ =l

Ok I Cancel Aipply
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Administrative note Add an optional note, up to 1024
characters.

User Synchronization Between the Exchange and
RightFax Servers

All database synchronization between RightFax and Exchange is
managed through Microsoft Active Directory. For information on
publishing RightFax servers to Active Directory, refer to the
RightFax Administrator's Guide.

Configuring the Connector to Work with
Multiple Exchange Modules

Only one RightFax connector can be installed on each Exchange
200x server, although each connector can communicate with
multiple RightFax modules through the specified message transfer
directories (described on page 16). Each connector/gateway
connection is assigned a priority. The connector will always use the
message transfer directory with the lowest priority setting. If a
message transfer directory can't be found, it will use the next
lowest. If two message transfer directories have the same priority,
the connector will alternate between them.
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The following diagram illustrates the use of connection priorities to
create redundancy in a multiple RightFax/Exchange 200x server
environment.

Figure 2.6 RightFax/Exchange 200x Server Redundancy

Microsoft
Exchange
Server

RightFax Connector

E-mail Gateway for MS Exchange (A) |

J
E-mail Gateway for MS Exchange (B) '\

Microsoft
Exchange
Server

RightFax Connector

Server redundancy is enabled by assigning multiple message
transfer directories (one per installed gateway) to a single
connector and assigning each a different priority level. For
information on configuring message transfer directories in the
RightFax connector for Microsoft Exchange, see “Message transfer
directories” on page 16.

E-mail Gateway for MS Exchange
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Installing the Connector for Exchange 200x
on a Windows 200x Cluster

R

ImportantThe Connector for Microsoft Exchange 200x requires that
your cluster environment be configured as Active-Passive. It will not
function in an Active-Active Cluster configuration.

Installing the Connector for Exchange 200x on a Windows 200x
cluster requires these basic steps:

Create the mail directories (page 19).

Install the connector on the primary node (page 19).

Install the connector on the secondary node (page 19).
Create the RFAXGATE resource (page 20).

Create the file share resource (page 20.

Change the mail directory paths (page 20).

Modify the Windows Registry (page 20).

@ N o o kDb

Test communication between the two servers (page 21).

Creating the mail directories

1. From the root of the cluster shared drive, create a new folder
named RFaxGate. Add two subfolders to this folder named
RFaxGate\ln and RFaxGate\Out.

2. Right-click the RFaxGate folder and select Sharing from the
shortcut menu. This opens the Properties dialog box with the
Sharing tab displayed.

3. Select Share this folder and type “RFAXGATE" in the Share
name box.

4. Click Permissions, and then click Add.

5. Select the service account used by the Exchange e-mail
gateway service and click Add. Click OK.

9.

Select the service account you added and allow full control.
Click OK to return to the Properties dialog box.

Select the Security tab and click Add.

Select the service account used by the Exchange e-mail
gateway service and click Add. Click OK.

Select the service account you added and allow full control.

10.Click Advanced.

11.Check the Reset permissions on all child objects and enable

propagation of inheritable permissions check box and click
OK.

12.Close the Permissions dialog box.

Installing the connector on the primary node

R

Important You must be working at the Exchange console for the
connector to install properly. Connecting remotely to the server will result
in an “unknown error” message and the installation will fail.

1.

Log on to the primary node using an account that is a member
of the Domain Admins, Enterprise Admins, and Schema Admins
groups.

Install the Exchange 200x connector according to the
instructions in “Installing the RightFax Connector on Microsoft
Exchange 200x Servers” (page 13).

Installing the connector on the secondary node

1.
2.

Fail over to the secondary node.

Install the Exchange 200x connector on the secondary node
according to the instructions in “Installing the RightFax
Connector on Microsoft Exchange 200x Servers” (page 13).

Chapter 2 Installing the RightFax Connector
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Creating the RFAXGATE resource

1.
2.

©® N @ o

Fail back to the primary node.

Run Cluster Administrator and open the Exchange cluster
group.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name box, enter RFSERVER.

In the Description box, enter RightFax Exchange Connector.
Set Resource Type to Generic Service.

Select the Exchange group.

In the Possible Owners box, enter the names of both nodes in
the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the MS Information
Store, MS MTA, and MS System Attendant resources.

10.Click Finish to add the resource to the group.

Creating the file share resource

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

2. In the Name box, enter RFaxShare.

In the Description box, enter RightFax File Share for
Connector.

Set Resource Type to File Share.

5. Select the Exchange group.

In the Possible Owners box, enter the names of both nodes in
the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the Cluster Name and
Physical Disk resources.
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In the Generic File Share Parameters box, enter the path to
the RFaxGate folder you created on the virtual drive. Be sure to
use RFAXGATE as the share name.

Click Finish to add the resource to the group.

Changing the mail directory paths

1.
2.

Open the Exchange System Manager.

For each node, open the Exchange Connector’s Properties
window and click the Fax Server tab.

Change the directory path from C:\Program Files\RightFax
\RFaxGate to \\ClusterName\RFAXGATE on both connectors.

Change the Location of mail files path to the RFaxGate folder
on the cluster shared drive.

. For the second node only, remove the FAX* and RFAX*

namespace.

Click OK to re-set the gateway.

Modifying the Windows Registry

When the Exchange Connectors are installed on the cluster nodes,
they each point to different MTS queues. The registry needs to be
modified to point them both to the correct queue.

1.
2.

Open the Windows Registry on the secondary node.

Navigate to HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Services\RFaxGate\Parameters.
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3. Replace the computer name of the secondary node (delimited

R

by brackets) with the computer name of the primary node for the
following registry values:

o ADSConnector
e ADsPath
¢ CommonName

Important Do not change the settings for HomeDSA.

4. Re-start the Exchange connector.

Testing communication between the two servers

1.

Ensure that the Exchange connector service on the active node
and the gateway service on the RightFax server are running.

On the active node, navigate to the virtual drive where you
created the RFAXGATE file share.

Open the In and the Out folders in separate windows and set
each view to Details.

Each folder should contain a file called Pulse.txt.

5. Check the “modified” time and date of each Pulse.txt file and

compare them to the actual server time. The time and date of
both Pulse.txt files should always be within one minute of the
server because they should automatically update every 45
seconds.

o [f Pulse.txt in the In folder is not updating, ensure that the
RightFax Connector service on the Exchange server is
running.

¢ If Pulse.txt in the Out folder is not updating, ensure that the
E-mail Gateway service on the RightFax server is running.

o If both Pulse.txt files are updating properly, send a test fax
through the Exchange gateway.

Chapter 2

Installing the RightFax Connector
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Chapter 3
Configuring Outlook Users to Send

and Receive Faxes

The RightFax Microsoft Exchange Module supports these versions

Installing the RightFax Forms for Outlook

of Microsoft Outlook:

e Outlook 2000 SP3
e Outlook XP base version and SP12

Sending an Outlook mail message to a fax number is similar to
sending e-mail, except the message must be specially addressed.
Text entered in the Subject field in an Outlook mail message will
appear in the “Notes” section of the cover sheet. Text entered in the
body of the e-mail will appear as the body of the fax. Attached files
will be converted to fax images and added to the fax (see Appendix
B, “File Formats that Convert to Fax Format”). Unsupported file
attachments cannot be converted and will be ignored.

Important UTF-8 encoding (unicode) is required for the Euro symbol
and some other special characters to appear properly in RightFax
documents created in Microsoft Outlook. To support documents with
these characters, Microsoft Outlook must be configured for UTF-8
encoding. Refer to the documentation for Microsoft Outlook for
information on enabling UTF-8 encoding.

RightFax provides custom forms for your Microsoft Outlook users
that expand and simplify the process of sending and receiving faxes
with Outlook. Features such as an embedded fax viewer and billing
code lookup tables allow Outlook to act as a truly unified
messaging client for your users.

RightFax includes two types of Outlook forms: an advanced
(full-featured) form and a standard form that includes fewer
features.

Note Both the standard and advanced Outlook fax forms require
Microsoft Outlook 98 or higher be running on the client workstation.

With the standard form, users can:

o Enter billing information.
e Send a cover sheet.

o Specify conversion options for PowerPoint, Excel, and Visio
documents.

o Elect to preview a fax before sending, request a callback, and use
smart-resume.

o Specify the resolution of the fax image.
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The advanced form includes the same features, and users can:

o Select defaults for conversion options, cover sheets, and other
sending information.

o Preview and select library documents to attach to the fax.
¢ Preview and select fax overlay forms.
o Look up billing codes.

Preview forms can be installed so that users can preview faxes in
Outlook before sending them. The advanced preview form displays
the fax in the RightFax viewer. The standard form utilizes the default
viewer defined for the file type.

The forms can be installed and configured (“published”) for all
Outlook clients at one time. To use the advanced form, it is also
necessary to install and configure each client individually.

To install the forms to all Outlook client computers

Repeat the following steps for each form you want installed.

1. Ensure that your Exchange server has an Organizational Forms
Library configured. Run the Exchange System Manager. Select
Public Folders and then click the Action button and select
View System Folders from the menu. Select the system folder
EFORMS REGISTRY. If an Organization Forms Library is not
listed, add one by right-clicking EFORMS REGISTRY, and then

selecting New > Organizational Form from the shortcut menu.

2. Open the Permissions settings for the Organizational Forms
Library and set the administrator who is installing the RightFax
forms as the Owner of the Forms Library.

3. Close the Permissions dialog box.
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4. Double-click the file name for the form to install. The following
table lists all of the available forms.

Table 3a File Names for Exchange Forms on the RightFax Server

Form Language File name
English FormEN.oft
French FormFR.oft
French-Canadian FormFC.oft

Standard form German FormGR.oft
ltalian FormlIT.oft
Portuguese FormPR.oft
Spanish FormSP.oft
English FormENp.oft
French FormFRp.oft
French-Canadian FormFCp.oft

Standard preview form | German FormGRp.oft
ltalian FormlTp.oft
Portuguese FormPRp.oft
Spanish FormSPp.oft

5. When prompted, click Enable Macros. This opens the form.

6. On the Tools menu, click Forms and then click Publish Form
As. This opens the Publish Form dialog box.

7. In the Look In box, select Organization Forms Library.
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8. In the Display Name box, type a descriptive name for the form,
such as the names shown in the following table. The name will
appear in the Form Name box. Verify the message class for the
form, as shown in this table.

Table 3b Display Names and Message Classes for Exchange Forms on
the RightFax Server

Form Display name Message class

Standard form RightFax IPM.Note.RightFax

Standard preview | RightFax Preview | IPM.Note.RightFax.Preview
form

9. Click Publish.

Installing the advanced fax form on a client computer

The advanced RightFax form for Outlook is installed on each
individual Outlook client computer as a component of the RightFax
client installation (described in the RightFax Installation Guide).

The Outlook Fax Extension

The Outlook Fax Extension is installed as part of the advanced fax
form installation. The extension adds a menu command and button
to Outlook so that users can quickly address and send faxes. It also
provides a command for viewing the status of faxes.

A button, New Fax to Contact, is added to the Outlook tool bar.

Figure 3.1 The New Fax to Contact Button
]

Faz

|New Fawx to Cantact

When the user clicks this button, a Quick Fax Addressing dialog
box may appear depending on the user’s RightFax configuration in
Outlook (see “Configuring the Outlook Fax Extension” on page 26).
This dialog box lets the user easily enter the necessary fax
addressing information. After the addressing dialog box is
completed, the fax form opens allowing the user to supply the body
of the fax message, attach files or library documents, and specify
any desired fax transmission options.

The extension adds the menu command Realtime Fax Status to
the Actions menu so that users can view the status of the faxes
stored in the RightFax mailbox. This is useful for users who want to
check the status of faxes sent to or from Outlook. When this
command is selected, a dialog box appears listing the folders and
faxes in your mailbox. Click a folder name to view the faxes it
contains. To view or delete the fax, right-click the fax entry to open a
shortcut menu, and then select the appropriate menu option.
Right-click in the fax list and select Refresh List to view the most
current status of each fax.

Chapter 3 Configuring Outlook Users to Send and Receive Faxes
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Configuring the Outlook Fax Extension

The Outlook Fax Extension must be configured on each Outlook
client computer. On the client computer in Outlook, navigate to the
Tools menu and select Options. The Options dialog box opens.
Select the RightFax tab.

Figure 3.2 The RightFax Extension Tab
Options 2] x]

Preferences I Mail Services | IMail Format Spelling I Security I
Other RightFax Delegates

RightFax

o ¥ Use Outlook fax addresses as RightFax addresses
- V¥ Remaove "[Business Fax]" from cover sheet display name
¥ Allow area codes in parentheses
¥ Show Quick Fax Addressing dialog
Form far new messages:

IAdvanced RightFax Form j

Server Options. ..

SMTF Conversion

RFax [T Create intemet mail fax addresses

Fax gateway Internet mailbox:

Sample; fax=1234@gateway. company.com

[e]4 I Cancel | Apply |

Use Outlook fax addresses as RightFax addresses
Enables the gateway to send messages to Contacts who have a
fax number only in the Business Fax field of their Contact
information. If this check box is not selected, RightFax-specific fax
addresses must be used in the Business Fax field.
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Remove “(Business Fax)” from cover sheet display
name When faxing to Outlook clients, the name of the Contact
information field where the fax number was retrieved (the Business
Fax field) is automatically appended by Outlook to the fax
recipient’s name. For example, your Outlook Contacts may receive
faxes addressed like this:

Jane Doe (Business Fax)

Select this check box to automatically remove this text from your fax
cover sheets, leaving only the recipient’s name in the To: field.

Allow area codes in parentheses Prevents Outlook from
automatically converting numbers below 299 inside parentheses in
fax-bound mail addresses to escape characters. If you are going to
send faxes via the RightFax Microsoft Exchange Module to area
codes below 299, this check box must be selected.

Note Checking Allow area codes in parentheses will prevent you from
adding special characters to e-mail addresses using escape codes.

Show Quick Fax Addressing dialog When this option is
selected, a Quick Fax Addressing dialog box will appear each
time you create a new fax in Outlook. This dialog box lets you enter
fax addressing information, which is then formatted automatically in
the To line of your Outlook message.

Form for new messages Specifies which Outlook form to
open when you create a new fax. You can select the Outlook
standard message form, or, if you have installed RightFax forms
(see “Installing the RightFax Forms for Outlook” on page 23), you
can select the advanced form.

Server options Click this button to open a dialog that lets you
specify the name of the RightFax server to connect to and your
login information.

Create internet mail fax addresses |If you use the Outlook
client with the SMTP/POPS3 e-mail gateway instead of the RightFax
Microsoft Exchange Module, selecting this check box tells Outlook
to create SMTP/POP3 compatible fax addresses instead of
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Exchange formatted addresses. When this option is enabled, you
must also enter the Internet mail address of the RightFax SMTP
e-mail gateway. For example, if fax messages sent to the
SMTP/POP3 gateway should be formatted as:

fax=555-1212/pn=Jane.Doe@faxgateway.company.com
then this field must read:
faxgateway.company.com

Because this feature uses |IETF addressing convention, you must
have the option Use IETF Fax Addressing checked in your
SMTP/POP3 E-mail Configuration dialog box (described in the
RightFax Administrator’'s Guide)

Sending Faxes

When users open one of the two RightFax forms to send a fax
(such as by clicking the New Fax to Contact, button to open the
Advanced form, described on page 25), the Quick Fax Address
dialog box opens.

The Quick Fax Address dialog box

Name: |Jane Dos

=l FawNumber | [5551212

Woice Mumber: |555-1000
Company: |Acme, Inc.
Citw/State: [Anpwhere, USA

Dane I Add Anather > | Lancel |

This dialog box lets the user enter all the required addresing
information for one or more recipients. After adding one recipient,
click Add Another to add additional recipients. If the RightFax
server has been configured to send fax documents to e-mail

addresses or SMS numbers, a drop-down list lets you select which

of these delivery methods you want. Users can send a single

A

document to any combination of Fax, e-mail, and SMS recipients.
E-mail recipients will receive an e-mail message with the body of
the fax as a separate file attachment. SMS recipients will receive
only the notes entered for the fax cover sheet.

After the information for all intended recipients is complete, click
Done. The fax form opens, allowing the user to supply the body of
the fax message, attach files or library documents, and specify any
desired fax transmission options.

For instructions on entering this information, please refer to the
RightFax Client for Outlook Quick Reference Card and the online
help.

Note When sending faxes from Outlook, users can select fax recipients
from the Outlook address book and Contacts list. In Outlook, recipient
names can be 99 characters or longer, however the RightFax software
cannot display a name that is more than 99 characters. Faxes will send
successfully, however the recipient name will appear in distinguished
name format in RightFax and on the fax cover sheet.

Sending faxes using the standard fax form

After it has been installed, all Outlook users can open the standard
form. The standard form is similar to the advanced form but does
not include the lookup options.

Chapter 3 Configuring Outlook Users to Send and Receive Faxes
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1. In Outlook, on the Tools menu, select Forms, and then click
Choose Form.

2. In the Organizational Forms Library, double-click the display
name defined for the standard form (such as “RightFax”) This
opens the standard fax form for Outlook.

Figure 3.3 The Standard Fax Form in Outlook

% Untitled - RightFax (HTML)
Eile Edit Miew Insert Format Tools Actions Help |
=iend | ol 5| & s BB (B 0 (8@ B[t 4 | ¥ | Eomens
Marmal ~| arial S =

Message I Advanced Faxing Options I Help ]

o By
=

— Cost Recovery Imformation: ———————————— Cower Sheet Infarmation
Fi ! 8 DeFault]
Bil Info 1 [{Default: ~ ez | RN =
Personal Woice Murmber: I{DeFauIt} LI
L {D=rault) = Personal Fax Mumber: [{Dsfault: =l
— Cover Sheet Defaults General Fax Mumber: I{Default} ;I
I¥ send Cover Sheets? Fax Resolution:
2 7 call Back Requested?
Cover Sheet Model: I{DeFauIt} 'I
I{Defau\t} -I 7 Use Smart-Resume?
I Preview Fax Before Sending?
Form Owvetlay Code: Library Docurnent IDs (Separate with Semicolons):

— Document Conwersion Options

Power Point Specific Options: Excel Specific Cptions:
OUERUE TPe: [Siices =1 % Farce Black and White Output?
[¥ Frame Slides? ¥ Remove Cell Patterns?
7 Fit To Page? I only Fax Active Sheet?

v 7
¥ Force Visio Documents ko Black and White? I7 Include Charts in Fax?

< |

For information on using the standard RightFax form for Outlook,
please refer to the RightFax Client for Outlook Quick Reference
Card and the online help provided with the form.

Sending faxes using the advanced fax form
In order for a user to open the advanced form, the form must have
been installed separately on the client machine (see “Installing the
advanced fax form on a client computer” on page 25).
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There are several ways to use the advanced form to send a fax:

¢ Click New Fax to Contact.

e On the Actions menu, click New Fax.

o To generate and send a new fax to a Microsoft Outlook Contact,
click Contacts in your Outlook Folder List, select the contacts to
receive the fax, and then click New Fax to Contact on the tool
bar.

The form opens, addressed with the name and fax number of the
contact. The fax number is taken from the contact’'s Business
Fax fields. If the Business Fax field is empty, the Home Fax field
is used. If the Home Fax field is empty, the Other Fax field is
used. If available, the contact’s company, city, state, billing
information, and voice number will also be included in the fax
address for display on the cover sheet.

Figure 3.4 The Advanced Fax Form in Outlook

% Untitled - RightFax Advanced Form (Rich Text) -0 ﬂ
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For information on using the advanced RightFax form for Outlook,
please refer to the RightFax Client for Microsoft Outlook Quick
Reference Card and the online help provided with the form.

Sending Faxes Using Certified Delivery

A

If you have the RightFax SecureDocs Module installed, users can
send faxes from the Outlook Advanced form using Certified
Delivery. When a document is sent via Certified Delivery, it is saved
as a TIFF file on your organization's Certified Delivery Web server.
The recipient is not sent the document directly. Instead, the
recipient is sent an e-mail message with a link to the document on
the Web server. For information on installing and using Certified
Delivery, refer to the RightFax SecureDocs Module Guide.

Note The Advanced Form for Outlook currently supports sending via
Certified Delivery only. Sending via SecureDocs will be supported in
future versions. The Advanced Outlook form includes a SecureDocs
options button which opens a dialog box containing sending options for
SecureDocs. These options are currently unused and will not affect how
documents are sent with Certified Delivery.

To send a document via Certified Delivery, the user must specify an
e-mail address for the recipient instead of a fax number. The e-mail
address can be entered in the Fax Number/E-mail Address box
on the Quick Fax Addressing dialog box, or it can be entered in
Outlook’s To: or Cc: boxes.

In the Quick Fax Addressing dialog box, the user only needs to
specify the recipient's name and e-mail address. After a name and
e-mail address have been specified, the user must open the
Advanced Outlook form and select the Convert SMTP Addresses
To SecureDocs Recipients option. When this option is selected,
the e-mail address specified in the Quick Fax Addressing dialog
box will be converted to the proper format for sending via Certified
Delivery.

If the user is not using the Quick Fax Addressing dialog box, the
recipient’s name and e-mail address must be entered in Outlook’s
To: or Cc: boxes using the following syntax:

[RFAX:Name@/SMTP=EmailAddress/SD]

Where Name is the recipient’s display name and EmailAddress is
the destination e-mail address. For example, to send a fax via
Certified Delivery from Outlook to JaneDoe@Company.com, enter
this address in the To: field:

[RFAX:Jane Doe@/SMTP=JaneDoe@Company.com/SD]

Documents sent to addresses formatted this way in Outlook will
automatically be sent via Certified Delivery and the Advanced
Outlook form is not required.

Manually Addressing Outlook Messages
to Fax Destinations

To address a fax from Outlook, you can type all the fax information
(name, fax number, etc.) in the To: field using one of two supported
addressing formats, or create custom fax addresses in either your
Personal Address Book or the Global Address List.

Using the FAX: addressing format

This is a simplified fax addressing type that lets users specify the
destination name and fax number in the To: field in Outlook using
the format:

[FAX:Name@ FaxNumber]

For example, to send a fax from Outlook to Jane Doe at 555-1212,
enter this address in the To: field:

[FAX:Jane Doe@555-1212]

Be sure to include the opening and closing square brackets.

Chapter 3 Configuring Outlook Users to Send and Receive Faxes

29



You can restrict users’ ability to use this addressing type in the
RightFax Connector for Microsoft Exchange (see “FAX Addresses”
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following table lists all fax destination parameters supported for
Outlook. These addressing parameters can appear in any order but
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on page 16) must always be entered after the ‘@’ symbol in the address.

Using the RFAX: addressing format Figure 3.5 RFAX Type Outlook Fax Addressing Parameters

This is an advanced fax addressing type supported by RightFax that Parameter | Definition Example
lets users specify the destination name and fax number in the To: /AN= Billing code 1 /AN=1111
field in Outlook using the f t:
1¢1d In LUtlook Using the forma /Cl= Recipient city/state /Cl=Tucson, AZ
RFAX:N /FN=FaxNumb
[ ame@ axNumber] /CO= Recipient company name /CO=Acme, Inc.
F le, t fax f tlook t Doe at 555-1212
or examp & 10 Ser'wd a fax rom O_u ook to Jane Doe a ' /FN= Destination fax number /FN=555-1212
enter this address in the To: field:
[RFAX:Jane Doe@/FN=555-1212] /MN= Billing code 2 /MN=2222
/SMS Send to an SMS number /SMS=555-1212

Be sure to include the opening and closing square brackets. instead of a fax number

You must include the recipient’s name and fax number as in the (replaces the /FN parameter)
previous example; however, with the RFAX addressing type, you NN=

can optionally include one or more additional parameters. The

Recipient voice number /VN=555-4567

Example [RFAX:Jane Doe@/FN=555-1212/VN=555-4567
/Cl=Tucson, AZ/CO=Acme Inc./AN=1111/MN=2222]

You can restrict users’ ability to use this addressing type in the
RightFax Connector for Microsoft Exchange (see “RFAX
Addresses” on page 16).

Adding fax entries to your personal address book or the
global address list

If you have some fax contacts who you send to regularly, it may
save time to add their fax addressing information to one of your
phonebooks, rather than manually entering their fax destination
each time.



To add fax address entries to a phonebook 2. From the list of templates, select RightFax Address, and then

select the address book for the new entry. Click OK. This opens

1. In Outlook, create a new message and click To:. This opens the the New RightFax Address Properties dialog box.

Select Names dialog box. Click New to open the New Entry

dialog box. Figure 3.7 The New RightFax Address Properties Dialog Box

Fi The New Entrv Dialog Box in Outlook
igure 3.6 The New Entry Dialog Box in Outloo
9 y 9 Eusinessl Phone Numbersl Maotes  RFAX - General |

Select Names ] — Addiess Book Information
Show Mames from the: IGInha\ Address List j Mame az it will appear in the Exchange Address Book: I.Jane Doe
Type Mamne or Select from List: ~Ta...
New Entry [ x| Mame: IJane Doe
Abraham, 520555
sy Sefectthe enty e ok | EaNumber: | 15205851212
Alamar, T |ec:Mal Address - Woice Mumber:  |1-520-555-2345
Alexands | [Microsoft Mai Address _I Cancel B I
Anderson MacMail Address LCompany: IAcme, Inc,
Angel, St Help
Anhoury, ress City/State: |Tucsun.AZ
Applegate [ 400 Address
Armisteac [Other Address — Billing Cod
Amold, D) [Perzonal Distiibution List R
Austin, Ke Billing Infal: |1 111
WT-All
4 H Bilinglrfoz [2222
Mew. | [ Put this entry

_=————— | Inthe |Personal Address Book j Addto; To | e Beo Send Options, . |

£ In this message only

Ok I Cancel | Help |

3. Fillin the recipient’s fax information. The name you enter under
Address Book Information is the recipient's name as it will

appear in your address book. It is not included on any sent
faxes.

4. When you have entered all the recipient’s fax information, click
OK and complete the e-mail message. The new entry will now
be available in the address book you specified.
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Receiving Incoming Faxes via E-mail

The RightFax Microsoft Exchange Module lets RightFax users
receive faxes as e-mail message attachments instead of (or in
addition to) receiving them in their FaxUtil mailboxes.

To configure a user to receive faxes in e-mail

1. In Enterprise Fax Manager, double-click the user to open the

User Edit dialog box, and then click the Inbound Routing tab.

Figure 3.8 The Inbound Routing Tab

userbct 20
Outbound Auto-Printing I Default Receive Settings Motific:atian I Other I
Identification I Permissions Inbound Routing Default Outbound Settings

Routing Code [DID/DMIS number]:
[
Routing Type:
I Microzoft Exchange j
File Farmat:
| TIFF (G3-1D) =l
Routing Infa:
JJANE DOE

Erter a unigue recipient 10 for M5 Exchange. alid IDs are: Display Mame, Alias or
Distinguished Mame [DM). The DM is preferred. I pou are going ta be syncing with
Exchange. the DN iz required.

Received Fax Routing Farm:
IAdvanced Outlook Form j

¥ Delete after routing?

Cancel

2. In the Routing Type box, select “Microsoft Exchange

3. In the File Format list, click “TIFF-G3" as the format RightFax
will use for the fax attachment.
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4. In the Routing Info box, enter the Outlook user’s Display Name,
Alias, or Distinguished Name. To prevent possible duplication,
the Distinguished Name is recommended. If you are synching
users with Outlook, you must enter the user's Outlook
Distinguished Name

5. If you have installed Outlook forms (see “Installing the RightFax
Forms for Outlook” on page 23), select the form you want to
route incoming faxes to in the Received Fax Routing Form box.
Select Default to use the form set in the e-mail gateway
configuration in Enterprise Fax Manager (see “Adding and
Configuring the RightFax Microsoft Exchange Module Service”
on page 6).

6. Select the Delete After Routing check box only if you want to
delete the fax from the user's RightFax mailbox after it is routed
to Exchange. If RightFax cannot route a fax to the destination
e-mail mailbox, it will leave the fax in the user’'s RightFax mailbox
regardless of how this option is set.

Breaking up large faxes

Some Exchange servers define a maximum file size for inbound
messages. By default, if a fax image attached to an inbound mail
message exceeds this maximum file size, an error is logged and the
message is not sent.

In order to bypass this limit, RightFax can be configured to
automatically break fax images into multiple files and send them as
separate mail messages. To do this, add a new DWORD Windows
registry entry “MaxMessageSize” under HKEY_LOCAL_MACHINE
\Software\RightFax\Gateway\Gateway#. Set the value of this key
to the maximum file size in Kb. Any faxes that exceed this size will
automatically be divided into multiple faxes and multiple mail
messages.
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E-mail Notification of Received Faxes

The RightFax Microsoft Exchange Module can be used for
notification of received faxes whether or not the gateway is
configured to actually send and receive faxes.

To configure a user to receive fax notification in e-mail

1. In Enterprise Fax Manager, double-click the user to open the
User Edit dialog box, and then click the Notification tab.

Figure 3.9 The Notification Tab
2]

Identification | Permiszions | Inbound Routing | Default Outbound Settings I
Outbound Auto-Printing I Default Receive Settings Maotification | Other

Motification Method: IMicmsoft Exchange j

Motification Address/Info:
JJAME DOE

r— Naotification about outbound faxe:
I Begirning of Transmission
™ Diuring Transmission
™ Enor encountered, b will be retried
V¥ Ener encountered, fax will be abandaned
¥ Faxiz successhully sert

¥ Faxis incomplete

™ Fax remaing incomplete

™ Faxis held/ready for approval

— Matification about received faxe:
¥ wihen initislly received
I~ “while fax has not been viewed of printed
™ Reroute received fax notification?
Feroute to user: j

Cancel

2. In the Notification Method list, click Microsoft Exchange.

3. In the Notification Address/Info box, enter the Outlook user's
Display Name or Alias. Click OK to save the new notification
settings.

Group notification

The notification method can be configured for an entire RightFax
group by editing the group ID properties in Enterprise Fax Manager
and setting the group Notification Type to Microsoft Exchange.

Customizing the subject lines of Exchange user
notifications

The subject line of each user notification message in Exchange can
be customized by adding a Windows registry setting to the fax
server. For each message to customize, add a new string registry
entry under HKEY_LOCAL_MACHINE\Software
\RightFax\Gateway\Gateway#. The following table lists each
registry entry, the type of notification the message applies to, and
its default text value. Some values let you include variables as part
of the string. In each case the variable and its definition is listed.

Table 3c Custom Exchange Subject Line Registry Settings

Defines the

Registry key subject line of | Default value

ExchangeMsgs_0 | Received A new fax has arrived from ~1 (Part
Outlook ~2 of ~3).
messages that ~1 = CSID of originating fax machine
contgln newly ~2 = Part of the fax (if fax is broken
received faxes into multiple parts)

~3 = Total fax parts (if fax is broken
into multiple parts)

~4 = The number of the fax channel
that received the fax

~5 =The unique ID of the fax,
assigned by the RightFax server

~6 = ANl information

ExchangeMsgs_1 | Notification that | Your fax has not been sent because
a sent fax had an | the addressing information was
incorrect fax incorrect.

address

Chapter 3 Configuring Outlook Users to Send and Receive Faxes
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Table 3c Custom Exchange Subject Line Registry Settings (Continued)

Registry key

Defines the
subject line of

Default value

ExchangeMsgs_2

Notification that
a sent fax had an
invalid fax
address

Valid fax destination information could
not be found in your mail message.
The message has been discarded.

ExchangeMsgs_3

Notification that
a sent fax had an
invalid e-mail
address

The gateway was unable to validate
the e-mail address of the message
sender. The message has been
discarded.

ExchangeMsgs_4

Notification that
a sent fax was
not sent due to
an error during
processing

An error occurred while trying to
process your message. Please try
again or contact your system
administrator. The message has been
discarded.

ExchangeMsgs_5

Notification that
a sent fax was
not sent due to
an error during
transmission

An error occurred while trying to send
your message. Please try again or
contact your system administrator.
The message has been discarded.

ExchangeMsgs_6

Notification that
a sent fax
marked for
preview is ready
to view

Your fax to ~1 is ready for previewing.

~1 = Recipient's name

ExchangeMsgs_7

Notification that
a sent fax has
not been sent

Your fax has not been sent.

ExchangeMsgs_8

Notification that
a sent fax had no
body content

There is no message body.
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Including the Fax ID in the E-mail Notification

The e-mail notification of a received fax in Microsoft Outlook can
include the unique ID of the fax. The unique ID appears in the
subject line of the e-mail. To change the format of the unique ID,
see the chapter on routing inbound faxes in the RightFax
Administrator’s Guide.

To configure e-mail notification messages to include the
fax ID

For the unique ID of the fax to appear in e-mail notification
messages, you must modify the notification messages on the
RightFax server.

1. In Enterprise Fax Manager, select the RightFax server to modify.

2. Under Service Name, double-click RightFax Server Module.
The Server Configuration dialog box opens.

3. On the Custom Messages tab, modify the New Fax message.
Type a message that includes the ~5 variable, which is the
unique ID of the fax. The maximum length of a notification
message is 200 characters.

For example, enter the message A new fax has arrived. Fax ID
~5.
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Embedded Codes in E-mail Messages Embedded codes can appear anywhere in the body of the mail
message (they will not work in the Address or Subject fields).

Embedded codes are special faxing instructions that you insert Embedded codes cannot line wrap and any embedded code that is
directly into fax-bound documents such as e-mail messages. You so long that it wraps to a second line will be ignored.

can use embedded codes to include fax cover sheet information,

attach library documents, add billing information, and more. For a description and example of each e-mail compatible

embedded code see “E-mail Compatible Embedded Codes” on
To add an embedded code to an e-mail message, type the code page 37.

you want, along with any required parameters, between angle
brackets. For example, an embedded code that tells RightFax to
send a library document called “PriceSheet” is written as:

<LIBDOC:PRICESHEET>

RightFax removes all embedded codes from the mail message
when it converts it to fax form so they don't appear in your final fax.
If you type an embedded code incorrectly, it will be ignored by
RightFax and included in your fax. Embedded codes may be written
in either upper or lower case.

Embedded codes must always use a native printer font. This is
because when the mail message is converted to PCL5 format, all
other font types are encoded as graphic images. Only native printer
fonts are stored in the PCL file that the fax is generated from in
their original text format. And it is this text in the PCL file that is
replaced. If you do not use native printer fonts for your embedded
codes, the codes themselves will appear in the instead of being
replaced by the information or instruction they represent. All
embedded codes are surrounded by angle brackets (< >) which
must also use the same native printer font.

Note Windows 200x may add unexpected spacing or other characters

\ to embedded code strings even when using a native printer font. For
embedded codes in documents on Windows 200x machines, RightFax
recommends using the “Courier” native printer font only.
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Appendix A

E-mail Compatible Embedded Codes

Embedded codes are special faxing instructions that you insert
directly into fax-bound e-mail messages. You can use embedded
codes to include fax cover sheet information, attach library
documents, specify a time to send the fax, and more.

To add an embedded code to an e-mail message, type the code
you want, along with any required parameters, between angle
brackets. For example, an embedded code that tells RightFax to
include the library document “Priceguide” along with the text of the
e-mail is written as:

<LIBDOC2:PRICEGUIDE>

RightFax removes all embedded codes from the e-mail message
when it converts it to fax form, so they don't appear in your final fax.
If you type an embedded code incorrectly, it will be ignored by
RightFax and will be included in your fax. Embedded codes may be
written in either upper or lower case and embedded codes always
work the same way regardless of the e-mail application used to
create the document.

Although you can use any fonts you want in the text of your e-mail

messages, embedded codes must always use a native printer font.
This is because when the file is converted to PCL5 format, all other
font types are encoded as graphic images. Only native printer fonts
are stored in the PCL file in their original text format. It is this text in
the PCL file that is replaced. If you do not use native printer fonts

for your embedded codes, the codes themselves will appear in the

instead of being replaced by the information or instruction they
represent. All embedded codes are surrounded by angle brackets
(< >) which must also use the same native printer font.

Note Windows 200x may add unexpected spacing or other characters
to embedded code strings even when using a native printer font. For
embedded codes in documents on Windows 200x machines, RightFax
recommends using the “Courier” native printer font only.

Embedded codes can be placed anywhere in the e-mail message
that you will be faxing. They cannot line wrap and any embedded
code statement that is so long that it wraps to a second line will be
ignored.

This appendix lists only embedded codes that are recognized by
the e-mail gateways. RightFax supports several additional
embedded codes when faxes are generated from native
applications. For a complete list of embedded codes supported by
RightFax, please refer to the RightFax Administrator’s Guide.
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ATDATE

Format <ATDATE:date>

Schedules the fax to send on a specific date. Dates can be

expressed as relative or absolute. Relative dates give the number of

days from today's date. For example, “+7" represents one week
from today. Absolute dates specify the exact date to send the fax.
Absolute dates must be written in one of these formats:
MM/DD/YY, MM-DD-YY, or MM-DD-YYYY.

If no send time is specified with the ATTIME code (described later),
the send time defaults to “now” (the current time of processing).
For example, if a fax is sent to the queue at 3:30 p.m. and it
contains only an <ATDATE:+1> code, it will automatically be
scheduled to send at 3:30 p.m. tomorrow.

Maximum field length: 10 characters

Example <ATDATE:9-15-99>
<ATDATE:+2>

ATTIME

Format <ATTIME:time>

Schedules the fax to send at a specific time. The time can be
relative or absolute.

Relative time is the number of hours or minutes from the current
time. For example, “+2" is two hours from now.

Absolute times are entered in either 12-hour or 24-hour format. A
colon separating hours and minutes is optional, and an “a” or “p”
can be used to indicate A.M. or P.M. The fax server does not send
the fax at exactly the minute specified. Rather, the fax becomes
eligible for scheduling within 15 minutes of the specified time.

Specifying a time between the current time and midnight will
schedule the fax to send today. Specifying a time earlier than the
current time will schedule the fax tomorrow.
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Maximum field length: 9 characters

Example <RFSAP_ATTIME:10:00p>
<RFSAPAT_TIME:+2>

BILLINFO1

Format <BILLINFO1:code>

Assigns a billing code to the fax. The billing code will be sent but it
will not be validated by RightFax.

Maximum field length: 15 characters
Example <BILLINFO1:4444>

BILLINFO2

Format <BILLINFO2:code>

Assigns a second billing code to the fax. The billing code will be
sent but it will not be validated by RightFax.

Maximum field length: 15 characters
Example <BILLINFO2:5555>

CHANNEL

Format <CHANNEL:channel#>

Sends the fax only on the specified channel of the fax board.
Specify a number corresponding to the channel to use. Set the
channel number to O (zero) to use any available channel.

This code is useful if your organization uses one channel for priority
faxing, and you want the fax to go out right away. You can also use
this code to limit fax broadcasts to one channel only, leaving the
other channels free for priority faxing.

Maximum field length: N/A
Example <CHANNEL:3>
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COVER

Format <COVER>

Automatically generates a RightFax cover sheet for the fax
containing the code. If the user sending the fax containing this
code is configured to automatically generate a cover sheet, only
one cover sheet will be generated.

Unless a cover sheet file name is specified using the <FCSFILE>
embedded code (see “FCSFILE" on page 39), this code will
automatically use the default cover sheet file.

Maximum field length: N/A

DELETE

Format <DELETE>

Deletes the fax from the user's FaxUtil mailbox after it has been
successfully sent. This code overrides the default RightFax
auto-delete setting.

Maximum field length: N/A

DELETEALL

Format <DELETEALL>

Deletes all faxes from the user's FaxUtil mailbox after the fax has
been sent, whether or not the send was successful. This code
overrides the default RightFax auto-delete setting.

Maximum field length: N/A

FCSFILE

Format <FCSFILE:file name>

Uses the specified file as the RightFax-generated cover sheet. The

cover sheet file must exist in the RightFax\FCS folder on the
RightFax server and must end with the extension .pcl. Do not
specify a directory path.

Maximum field length: 12 characters
Example <FCSFILE:MYCOVER1.PCL>

FINE

Format <FINE>

Converts the body of the fax using “fine” resolution (200 x 200
DPI). Fine resolution is recommended for faxes with detailed
graphics and faxes that will be OCRed. This code overrides the
default fax resolution set in the user's FaxUtil mailbox.

Maximum field length: N/A

FROMFAXNUM

Format <FROMFAXNUM:faxnumber>

Specifies the sender’s fax number on the RightFax-generated fax
cover sheet. If no cover sheet is generated by RightFax, this code
will be ignored.

Maximum field length: 31 characters
Example <FROMFAXNUM:(520)555-1234>

FROMGENFAXNUM

Format <FROMGENFAXNUM:faxnumber>

Specifies the company’s general fax number to be placed on the
RightFax-generated fax cover sheet. If no cover sheet is generated
by RightFax, this code will be ignored.

Maximum field length: 31 characters
Example <FROMGENFAXNUM:(520)555-2345>

FROMGENPHONE

Format <FROMGENPHONE:phonenumber>

Appendix A E-mail Compatible Embedded Codes
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Specifies the company’s general phone number to be placed on
the RightFax-generated fax cover sheet. If no cover sheet is
generated by RightFax, this code will be ignored.

Maximum field length: 31 characters
Example <FROMGENPHONE:(520)555-3456>

FROMPHONE
Format <FROMPHONE:phonenumber>

Specifies the sender’'s phone number to be placed on the

RightFax-generated fax cover sheet. If no cover sheet is generated

by RightFax, this code will be ignored.
Maximum field length: 31 characters
Example <FROMPHONE:(520)555-4567>

IGNORE
Format <IGNORE>

Causes all subsequent embedded codes to be ignored.
Maximum field length: N/A

LIBDOC
Format <LIBDOC:documentlD>

Sends the specified RightFax library document in addition to
sending the document containing the code. Multiple library

documents may be specified, each as a separate LIBDOC code.
When used with e-mail gateways, this embedded code functions

exactly the same as LIBDOC2.
Maximum field length: 21 characters
Example <LIBDOC:INFOPACK1>

LIBDOC2
Format <LIBDOC2:documentlD>
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Sends the specified RightFax library document in addition to
sending the document containing the code. Multiple library
documents may be specified, each as a separate LIBDOC2 code.
When used with e-mail gateways, this embedded code functions
exactly the same as LIBDOC.

Maximum field length: 21 characters
Example <LIBDOC2:INFOPACK1>

NOCOVER

Format <NOCOVER>

Turns off automatic RightFax cover sheet generation for the
document containing this code.

Maximum field length: N/A

NORMAL

Format <NORMAL>

Converts the body of the fax using “normal” resolution (100 x 100
DPI). Normal resolution faxes can be transmitted much faster than
fine resolution faxes, saving time and phone charges. This code

overrides the default fax resolution set in the user's FaxUtil mailbox.

Maximum field length: N/A

PREVIEW

Format <PREVIEW>

Holds the fax for preview in your FaxUtil mailbox. You must view the
fax in FaxUtil and select Release from the File menu before it will
send.

Maximum field length: N/A

PRIORITY

Format <PRIORITY:priority>
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Sets the priority of the outgoing fax. Allowed settings are: Low (L),
Normal (N), and High (H). If a user specifies high priority and does
not have the “Can use high priority” permission, the fax will
automatically be sent with “normal” priority.

Maximum field length: N/A

Examples<PRIORITY:HIGH>
<PRIORITY:N>

SAVE
Format <SAVE>

Instructs RightFax to not delete the fax image from the user's
FaxUtil mailbox after being sent. This overrides any default
auto-delete setting.

Maximum field length: N/A

Appendix A E-mail Compatible Embedded Codes 41



RightFax 9.0 Microsoft Exchange Module Guide 42



Appendix B
File Formats that Convert to Fax Format

The following table lists the software applications and document Table B1 Supported Document File Formats (Continued)

file formats that can be converted to faxes by the built-in conversion

engine on the RightFax server. Only these file types can be

converted from their native format by sending as file attachments to

a fax message or by using the Send To function in Windows.

Table B1 Supported Document File Formats

Application or file format

Supported versions

GIF

Compuserve

HTML

Versions through 3.0

JPEG (includes EXIF)

All versions

Application or file format

Supported versions

Lotus 1-2-3 (DOS & Windows)

Versions through 5.0

Lotus 1-2-3 (0S/2)

Versions through 2.0

Lotus 1-2-3 Charts (DOS & Windows)

Versions through 5.0

ANSI text (7 & 8 bit) All versions
ASCII text (7 & 8 bit) All versions
Binary group 3 fax All versions

Lotus 1-2-3 Charts (0S/2)

Versions through 2.0

BMP (including RLE, ICO, CUR, and
0OS/2 DIB & OS/2 Warp)

Windows versions

CDR (if TIFF image is embedded in it)

Corel Draw versions 2.0
through 9.0

Lotus 1-2-3 for SmartSuite

SmartSuite 97,
Millennium, and
Millennium 9.6

Lotus AMI/AMI Professional

Versions through 3.1

DCX (multi-page PCX)

Microsoft Fax

Lotus Symphony

Versions 1.0, 1.1, and 2.0

DRW (Micrografx Designer)

Version 3.1

Microsoft Binder

Version 7.0, Binder 97

DRW (Micrografx Draw)

Versions through 4.0

Microsoft Excel Charts

Versions 2.x through 7.0

EPS

If TIFF image is
embedded

Microsoft Excel for Macintosh

Versions 3.0 through 4.0,
98, and 2001

Freelance for Windows

Version 1.0, 2.0, 96, 97,
and Millennium

Microsoft Excel for Windows

Versions 2.2 through
2002
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Table B1 Supported Document File Formats (Continued)

Application or file format

Supported versions

Microsoft Multiplan

Version 4.0

Microsoft PowerPoint for Macintosh

Version 4.0, 98, and
2001

Microsoft PowerPoint for Windows

Versions through 2002
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Table B1 Supported Document File Formats (Continued)

Application or file format

Supported versions

UUEncode

No specific version

WordPerfect Graphics (WPG and
WPG2)

Versions through 2.0

Microsoft Rich Text Format (RTF)

All versions

ZIP

PKWARE versions
through 2.04g

Microsoft Windows Works

Versions through 4.0

Microsoft Word for DOS

Versions through 6.0

Microsoft Word for Macintosh

Versions 4.0 through
2001

Microsoft Word for Windows

Versions through 2002

Microsoft WordPad

All versions

Microsoft Works for DOS

Versions through 2.0

Microsoft Works for Macintosh

Versions through 2.0

Microsoft Works for Windows

Versions through 4.0

Microsoft Write

Versions through 3.0

Novell WordPerfect for DOS

Versions through 6.1

Novell WordPerfect for Macintosh

Versions 1.02 through
3.0

Novell WordPerfect for Windows

Versions through 7.0

PCX bitmap

PC Paintbrush

PICT1 and PICT2 (Raster)

Macintosh standard

QuattroPro for DOS

Versions through 5.0

QuattroPro for Windows

Versions through 10

TIFF

Versions through 6

TIFF CCITT Group 3 & 4

Fax Systems

Unicode Text

All versions
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breaking up large faxes 32
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Certified Delivery 29
configure
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200x 14

connector for Exchange 200x
configuring 14
installing 13
overview 18

contacts, Outlook 29

custom messages 8

custom notifications 8

default form 7

embedded codes 35
eventlog 7

event log level 7
ExchSnap.dll 13

F

Fax Extension in Outlook 29
fax forms in Outlook 23
fax status in Outlook 25
FAX: addressing format 29
faxes
file formats for conversion 43
sending from Outlook 27
sending to Outlook contacts 28, 29
forms, Outlook 5, 23

G

GATEWAY command 11
Gateway for Microsoft Exchange
configuring 6
running remotely 9
troubleshooting 11
gateways
running in command prompt windows 11
starting and stopping Exchange service 9

Global Address List 30
group notification 33

install
advanced fax form for Outlook 24, 25
RightFax connector on Exchange
200x 13
standard fax form for Outlook 24
install the Gateway for Microsoft Exchange 6

L

location of mail files 7
LogLevel 7,11

notification of received faxes in Outlook 33,
34

(o)

Outlook
adding fax phonebook entries 30
addressing fax messages 29
default form 7
email notification with unique ID of fax 34
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Outlook (continued)
embedded codes 35
fax notification 33
faxing to contacts 28, 29
New Fax to Contact button 25
routing faxesto 32
Outlook Fax Extension
configuring 26
using to send a fax 29
Outlook forms
installing advanced 25
installing standard 24
overview 23
using advanced 28
using standard 27

P
Personal Address Book 30

real-time fax status in Outlook 25
remote email gateway service 7
remote operation of the gateway 9
RFAX addresses 30

RFax_in.dll 13

RFax_outdll 13

RFaxgate.exe 13

RightFax connector for Exchange 200x

installing 13
overview 5
RightFax document conversion 43

routing incoming faxes to Exchange 32

S

select service account 9

send faxes
using advanced form 28
using Certified Delivery 29
using standard form 27

service account, select 9

service, gateway 9

standard fax form 24

start gateway service 9

stop gateway service 9

T

troubleshoot the gateway 11

\'/

viewing the status of a fax in Outlook

25
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